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Objectifs

L'objectif de la formation est de maîtriser une alternative pérenne à Microso� Office© et de gagner en
efficacité sur un outil de traitement de texte mais aussi de présentation.

Nous aborderons différents sujets tels que :

les formats de fichiers pour bien comprendre les enjeux et problématique d'échanges de
documents,

les styles pour obtenir des fichiers propres et bien formatés,

les modèles de documents pour gagner en efficacité lors de la création de vos supports de cours,

les formulaires pour étendre les possibilités de nos fichiers, et notamment créer des PDF
modifiables,

les extensions qui sont une force pour un usage en milieu scolaire,

le publipostage pour ceux qui en ont besoin...

Enfin, nous prendrons du temps pour approfondir l'outil de présentation Impress. Nous n'aborderons
que très peu le tableur Calc.

Tout au long de la présentation, il sera fourni quelques trucs et astuces qui vous permettront d'enrichir
vos connaissances sur l'outil, la bureautique et le numérique en général.

4 cedric.frayssinet@ac-lyon.fr



Introduction

LibreOffice (parfois abrégé en LibO ou LO) est une suite bureautique libre, gratuite et open-source,
dérivée du projet OpenOffice.org, créée et gérée par The Document Foundation p.45.

Logo officiel LibreOffice
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Généralités I

1. Présentation

Une suite bureautique complète :

Composants de LibreOffice

Writer : le traitement de texte

Calc : le tableur

Base : base de données

Impress : présentation

Draw : le dessin vectoriel

Maths : formules mathématiques

Un projet mondial et libre !

Le bureau de la fondation compte quelques personnalités de la communauté OpenOffice.org venant de
plusieurs pays, mais l'actuelle présidente n'était pas présente au moment d'OpenOffice.org.

La fondation a le soutien de nombreux éditeurs de logiciels : Ubuntu, Novell, Suse, Red-Hat, Google...

Traduit en plus de 100 langues !

A chaque nouvelle version, de nouvelles langues sont disponibles mais on trouve aussi des langues
régionales : Catalan, Breton, Basque ou l'Espéranto...
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1 http://www.numerama.com/magazine/33357-windows-10-microso�-et-vos-donnees-privees-ce-que-vous-devez-sa
voir.html

2 https://github.com
3 https://www.nextinpact.com/brief/microso�-a-bien-rachete-github--pour-7-5-milliards-de-dollars-4212.htm

Multi-plateforme !

LibreOffice fonctionne aussi bien sur Windows©, MacOSX© et Gnu/Linux p.45.

2. Qu'est-ce qu'un logiciel libre ?

Définition

Un logiciel libre est un logiciel dont l'utilisation, l'étude, la modification et la duplication en vue de
sa diffusion sont permises, techniquement et légalement.

Les logiciels libres constituent une alternative à ceux qui ne le sont pas, qualifiés de « propriétaires » ou
de « privateurs ». Ces derniers sont alors considérés par une partie de la communauté du logiciel libre
comme étant l'instrument d'un pouvoir injuste, en permettant au développeur de contrôler
l'utilisateur, c'est d'autant plus le cas de nos jours avec Windows 10 et ses Conditions Générales
d'Utilisation1.

Remarque

Les logiciels libres sont intéressants pour tous les secteurs d'activité. C'est particulièrement vrai pour
l'éducation : écoles et établissements scolaires, collectivités territoriales et Éducation nationale, mais
également les acteurs institutionnels et associatifs de l'Éducation populaire.

LibreOffice étant un logiciel libre, il est à disposition de tous les enseignants et de tous les élèves sans
restriction. L'élève pourra donc utiliser indifféremment LibreOffice à l'école et chez soi, qu'il soit sur
Windows©, MacOsX© ou Gnu/Linux.

3. Confusions récurrentes

Attention

1 - Un gratuiciel, autrement appelé freeware, n'a rien à voir avec un logiciel libre, exemple : Adobe
Reader et Flash, Google Earth, Photofiltre, eDrawings, Sketchup, la très grande majorité des
applications issues des stores des appareils mobiles...

2 - De par sa nature, un logiciel libre est souvent gratuit mais il n'est pas interdit de le rendre rentable
en proposant des services associés

3 - L'open-source : le logiciel libre est un mouvement social qui repose sur les principes de Liberté,
Égalité, Fraternité ; l'open-source quant à lui s'attache aux avantages d'une méthode de
développement au travers de la réutilisation du code source du logiciel. La plateforme la plus connue
et utilisée de logiciels open-source est Github2 (récemment achetée par Microso� pour 7.5 Milliards de
$3).

Remarque

Les licences open-source n'interdisent pas la vente du logiciel, c'est d'ailleurs un des modèles
économiques de l'écosystème du libre.

Généralités
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4. Format de fichiers

LibreOffice utilise nativement le format de fichiers "Open Document Format" (ODF p.46) :

.odt : open document text

.ods : open document spreadsheet

.odp : open document presentation...

Fondamental

ODF est un format de fichiers de bureautique ouvert, normalisé et documenté !

Microso�© Office© utilise son format propriétaire (.doc, .xls, .ppt), format non standardisé et
peu documenté, tout du moins sur les serveurs mis à disposition du public.

Office© 2007 a introduit un nouveau format Office Open XML (.docx, .xlsx et .pptx) accentuant les
problèmes des utilisateurs.

Rappel

OpenXML a finalement été normalisé en 2008 (2007 pour ODF p.46) après un premier vote négatif
(source WikipediaHistorique des votes ISO p.47)

5. Point sur la compatibilité entre les suites...

LibreOffice permet d'ouvrir et de modifier tous les formats de fichiers :

tous les fichiers ODF : .odt, .ods, .odp...

les formats d'Office© 2003 et inférieur : .doc, .xls, .ppt, .pub, .vsd...

les formats de fichiers OpenXML (Office© 2007+) : .docx, .xlsx, .pptx...

Office 2003 et inférieur :

n'ouvre pas les fichiers ODF

ouvre les fichiers Office© 2007 et + (.docx, .xlsx, .pptx...), à condition que le pack de
compatibilité soit installé

Office 2007 et supérieur :

ouvre tous les formats de fichier Office©

2007 - 2010 n'ouvre pas correctement les fichiers ODF (ancienne norme 1.1)

2013 - 2016 ouvre correctement les fichiers ODF (nouvelle norme 1.2)

Quel est le meilleur format de fichier à utiliser ? Conseil

Après étude par une formatrice sur les 2 suites bureautiques, il semblerait que le format de fichier qui
permettent les meilleurs échanges entre LibreOffice et Office 2016 soit le format ODF. Voici un billet qui
explique tout ceci dans le détail (avec un document PDF à télécharger) : http://www.numericoach.net/?
Compatibilite-LibreOffice-5-MsOffice

Généralités
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1 http://fr.libreoffice.org/download/libreoffice-stable/
2 http://fr.libreoffice.org/download/libreoffice-fresh/
3 https://wiki.documentfoundation.org/ReleaseNotes/6.2

6. Versions de LibreOffice

Remarque

The Document Foundation maintient 2 versions en parallèle :

La version (ou branche) Stable : à privilégier pour les établissements scolaires ou les grosses
structures

La version (ou branche) Évolution : à utiliser chez soi ou partout à partir de la version mineure
X.Y.4.

Il s'agit d'un développement "AgileQu'est-ce que la méthode Agile ? p.47" et les nouvelles versions de
maintenance sʼenchaînent toutes les 5-6 semaines environ.

Principe de la numérotation

Numérotation des versions sur trois chiffres X.Y.Z :

X.Y désigne une version fonctionnelle avec :

X : version majeure

Y : version mineure

Z désigne les versions de maintenance.

Cette numérotation correspond à des branches de développement et cela permet aux packageurs
(créateurs des fichiers exécutables .msi, .dmg ou .deb) de savoir où on en est dans le cycle de vie de la
version.

Exemple

Au mois de décembre 2018 :

La version Stable est la 6.0.7, on peut la télécharger depuis le site1 de l'éditeur, il est important
de ne pas télécharger depuis une autre source !

La version Évolution est la 6.1.3, on peut la télécharger depuis cette page2 du site de l'éditeur.

Remarque

En ce moment, il s'agit d'un tournant puisque la branche 6.0 arrive en fin de vie.

Les appellations vont changer : la branche 6.1 va devenir la version Stable. Quant à la nouvelle branche
Évolution, nous allons voir apparaître LibreOffice 6.2 3!

Annonce nouvelle version !

Généralités
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Rappel

Toutes nouvelles versions de LibreOffice améliorent la prise en charge des fichiers Microso�, il est
donc important de mettre à jour de manière régulière LibreOffice !

Généralités
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1 Police OpenDyslexic

Les Styles et Modèles II

Utiliser de manière efficace une suite bureautique passe par l'usage des styles et des modèles.
LibreOffice utilise de manière approfondie les styles et c'est souvent ce changement qui est difficile à
aborder quand on passe d'Office à LibreOffice...

1. Les styles

1.1. Que sont les styles ?

Un style est un ensemble de formatages que vous pouvez appliquer aux pages sélectionnées, textes,
cadres et autres éléments de votre document pour modifier rapidement leur apparence. Lorsque vous
appliquez un style, vous appliquez tout un groupe de formatages en même temps.

Beaucoup de personnes formatent manuellement les paragraphes, les mots, les tableaux, la mise en
page et d'autres parties de leur document sans faire aucunement attention aux styles. Ils sont habitués
à écrire des documents en fonction d'attributs physiques. Par exemple, vous pouvez spécifier la famille
de police, la taille de cette police ou tout autre format tel que le gras ou l'italique.

Les styles sont des attributs logiques. Utiliser les styles signifie que vous arrêtez de dire « taille de
police de 14 pt, Times New Roman, gras, centré », et vous commencez à dire « Titre » parce que vous
avez défini le style « Titre » qui a ces caractéristiques. En d'autres mots, les styles signifient que vous
déplacez l'accentuation de l'apparence du texte (ou de la page ou tout autre élément) vers ce que le
texte est.

Appliquer des styles sur du texte [cf. Styles_Demo.webm]

Complément

Les styles aident à améliorer la cohérence dans un document. Ils rendent également les modifications
majeures plus aisées.

Par exemple, si vous décidez de modifier l'indentation de tous les paragraphes, ou de modifier la police
de tous les titres (exemple pour changer pour la police OpenDyslexic1).

Pour les longs documents, cette tâche simple peut être fastidieuse alors qu'elle est rendue très facile
par les styles.

Remarque

Enfin, les styles sont utilisés par LibreOffice dans de nombreux processus, même si vous n'en avez pas
conscience.

Par exemple :

Writer s'appuie sur les styles de titre (ou d'autres styles que vous spécifiez) lorsqu'il compile une
table des matières.

Quand vous définissez les marges de votre page, vous modifiez le style par défaut des pages

cedric.frayssinet@ac-lyon.fr 11
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Exemple de cours avec de nombreux styles Exemple

On pourra, avec ce cours, générer le fichier élève facilement, ou la table des matières

Exemple de cours avec des styles [cf. Exemple_Cours_Prof.odt]

1.2. Les styles disponibles dans les composants LibreOffice

Accès aux catégories de styles dans Writer

1. Styles de paragraphe

2. Styles de caractère

3. Styles de cadre

4. Styles de page

5. Styles de liste

6. Styles de tableau

Sélection des 6 catégories de styles dans Writer

Récapitulatif

Catégories de
styles Writer Calc Draw Impress

Page X X

Paragraphe X

Caractère X

Cadre X

Numérotation X

Tableau X

Cellule X

Présentation X X

Image inclus dans les
styles de cadre X X

Les Styles et Modèles
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1.3. Activités Pratiques sur les styles

Objectifs
Première approche avec les styles :

Application de styles existants

Modification de styles existants

Création d'un nouveau style

Utilisation des styles pour la mise en page des documents.

a) Application de styles simples

Formatages simples

Formater le fichier en téléchargement ci-dessous avec les styles par défaut de
LibreOffice :

Titre Principal

Sous-titre

Titre 1

...

Document pour la prise de notes à formater [cf. Document_a_Formater.odt]

Création d'une table des matières

Créer la table des matières de manière automatique du fichier formaté en utilisant la vidéo ci-dessous :

Création d'un sommaire [cf. Sommaire.mp4]

b) Modification de styles simples

A partir du fichier précédemment modifié, modifier les styles suivants :

Titre Principal

Titre1

Citation

Modification d'un style existant Méthode

Pour modifier un style, il suffit de :

Faire apparaître la fenêtre des styles ou plus récemment le volet latéral (raccourci F11)

Choisir (cf. p.12) le type de styles :

Paragraphe

Caractère

Cadre

Page

Puces

Choisir le style à modifier et faites un clic-droit dessus -> modifier.

Les Styles et Modèles
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Complément

Éditer un style avec un clic-droit

On pourra également sélectionner le texte à modifier
puis faire un clic-droit -> Styles -> Éditer le style. A ce
moment là, le style se mettra en évidence dans le
styliste.

c) Créer un nouveau style

2 méthodes simples pour créer un style

Pour créer un nouveau style, il faut partir du menu
contextuel que l'on obtient en cliquant sur un style. Cela
permet de ne pas avoir à définir un style en partant de
zéro. A partir de là, une fenêtre s'ouvrira avec de
nombreux onglets pour définir votre nouveau style, ne
pas oublier de lui donner un nom dans l'onglet
Gestionnaire.

On peut aussi partir d'une sélection réalisée dans notre
document et créer le style :

Actualisation automatique Attention

Si l'option d'actualisation automatique est sélectionnée (styles de paragraphe et cadre uniquement),
l'application d'un formatage direct à un paragraphe ou un cadre utilisant ce style dans votre document,
actualisera automatiquement le style lui-même.

Création d'un style de listes

En tant qu'enseignant, on réalise de nombreux devoir avec des questions. Nous allons créer un style
qui permet à notre consigne 'Compléter le tableau' de devenir automatiquement :

Question 1 : Compléter le tableau

Afficher le volet des styles (F11) et sélectionner le style de listes

Créer le nouveau style : Questions_numérotées

Les Styles et Modèles
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Dans l'onglet Options :

mettre le texte Question dans le champ avant,

puis : dans le champ après

valider.

Écrire une consigne dans votre document puis appliquer le style
Questions_numérotées Question 1: Ma consigne est... Question 2:
sdmjmsdvl,vmùsjùv,ùvljsd

Création d'un style avec la souris Complément

LibreOffice Writer - La souris a du style ! [cf. Style_Avec_Souris.mp4]

d) La gestion des formatages de pages

On a vu précédemment que les pages étaient aussi gérées par des styles. On peut en avoir le coeur net
en utilisant le menu Format / Page... :

Les styles sont partout dans LibreOffice

Cela permet donc toutes les fantaisies possible mais c'est surtout très utile quand on veut alterner des
pages au format portrait et paysage.

Insérer une page au format paysage dans le document de travail fourni
précédemment.

Les Styles et Modèles
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2. Les modèles

2.1. Qu'est-ce qu'un modèle ?

Un modèle est utilisé comme base pour créer d'autres documents.

Par exemple, vous pouvez créer un modèle destiné à tous vos cours qui contiennent le logo de votre
établissement. Tous les nouveaux cours créés à partir de ce modèle comporteront ce logo sur leur
première page.

Les modèles peuvent contenir tout ce que contiennent les documents habituels, tels que du texte, des
images, un ensemble de styles et des informations spécifiques à l'utilisateur comme l'unité de mesure,
la langue, l'imprimante par défaut et des personnalisations de menus ou de barres d'outils.

Complément

Tous les documents dans LibreOffice sont basés sur des modèles. Vous pouvez créer des modèles
spécifiques pour tous types de document (texte, feuille de calcul, dessin, présentation).

Si vous ne spécifiez pas de modèle lorsque vous débutez un nouveau document, alors le
document est basé sur le modèle par défaut de ce type de document.

Si vous n'avez pas spécifié de modèle par défaut, LibreOffice utilise le modèle vierge de ce type
de document qui est installé avec LibreOffice.

Exemples de modèles créés Exemple

Exemple de modèle pour un cours [cf. Modele_Sti2D_LMD.ott]

Exemple de modèle de The Document Fundation pour leurs guides officiels [cf.
LO_5_0_Chapter_Template.ott]

On pourra aussi trouver d'autres modèles sur cette pageCentre de templates (modèles) de LibreOffice p.47.

2.2. Activité Pratique : Création d'un modèle de document

Objectifs
Création et gestion de modèles de documents Writer pour réaliser ses cours.

a) Création d'un modèle

Pour des cours, un modèle de document a besoin des styles de paragraphe suivants :

Titre principal

Titre 1 à 4 environ

Paragraphe

Citation

Illustration et légende

Contenu de tableau...

Pour chacun des styles précédents, il faudra paramétrer la taille, la police, l'alignement, les effets de
caractères, les bordures éventuelles...

On pourra aussi rajouter des styles de listes qui permettent de mettre du texte en évidence, du type :

Petites icônes de questions avec lʼicône  ou des questions numérotées (cf. p.14)

automatiquement

Les Styles et Modèles
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Ou Astuce , Attention , Important , Note ...

Travail à faire ...

Enfin, on pourra définir un style de caractère qui permettent de faire des textes à trous.

En bas de page, on pourra rajouter des textes automatiques, du type :

date mais éventuellement dans le désordre,

le nom du fichier,

les numéros de page avec le nombre total de page...

Remarque

N'hésitez pas à piocher de nouveaux icônes dans la
galerie intégrée à LibreOffice

Exemple d'icônes se trouvant par défaut dans
la galerie de LibreOffice

b) Gestion des modèles de documents

Rappel

On peut créer autant de modèles de documents que l'on souhaite :

par classe,

par matière...

Il est bon de rappeler que, pour Writer, le modèle de document comporte une extension .ott.

Il existe plusieurs façons de gérer ses modèles de documents.

Les Styles et Modèles
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Sauvegarder son document pour en faire un modèle de document Méthode

Pour sauvegarder son document et en produire un modèle, nous pouvons utiliser 2 méthodes :

1. Menu Fichier -> Enregistrer sous -> Sélectionner l'emplacement, donner un nom au fichier mais
surtout bien sélectionner le format 'Modèle de texte ODF (.ott)'

2. Menu Fichier -> Modèles -> Enregistrer comme modèle... donner un nom à votre modèle,
sélectionner la catégorie 'Mes Modèles', puis 'Enregistrer'

Utilisation des modèles... Fondamental

Dans le 1er cas, vous pouvez enregistrer votre modèle où bon vous semble :

sur votre clé USB,

votre dossier Mes Documents...

Un double-clic dessus, via l'explorateur de fichiers de votre système d'exploitation, vous permettra de
partir sur un document vierge (Sans nom 1.odt) basé sur votre modèle et l'ensemble de vos styles.

Dans le 2ème cas, le modèle est sauvegardé dans le profil LibreOffice (cf. p.41) de l'utilisateur. Il n'est
donc pas 'retrouvable' facilement ! Pour créer un nouveau document Writer à partir de ce modèle, vous
utiliserez la méthode suivante :

Menu Fichier -> Nouveau -> Modèles

Dans la nouvelle fenêtre, clic sur votre modèle.

Interface de gestion des modèles

A noter que depuis cette dernière interface, vous pouvez réaliser des opérations : déplacer un modèle,
exporter et importer un modèle. Cette fenêtre est accessible de 3 façons :

1. Menu Fichier -> Nouveau -> Modèles

2. Menu Fichier -> Modèles -> Gérer les modèles

3. Le raccourci clavier Ctrl + Maj + N

Les Styles et Modèles
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Les Formulaires III

1. Généralités

Dans certains documents, il peut être intéressant de glisser quelques formulaires simple de saisie.

Nous nous concentrerons sur un usage simple d'un
formulaire mais il est à noter que les formulaires
peuvent être utilisés de trois manières :

• Pour créer un document simple que le destinataire
doit compléter, comme un questionnaire envoyé à un
groupe de personnes qui le complète et le retourne à
l'expéditeur.

• Pour lier une base ou une source de données et
permettre ainsi à l'utilisateur de saisir des informations.
Par exemple, quelqu'un qui s'occupe des commandes de
clients saisira des informations pour chaque commande
dans une base de données à l'aide d'un formulaire.

• Pour visualiser des informations gérées par une base
de données ou une source de données. Par exemple, un
libraire peut obtenir des informations à propos d'un livre
grâce à cette base de données.

Obtenir le menu des formulaires Méthode

Pour travailler avec les formulaires, vous devez faire apparaître les barres d'outils dans le menu
Affichage -> Barres d'outils -> Contrôles de formulaire, voici les 3 barres d'outils disponibles :
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Créer des formulaires PDF Fondamental

Avec cette méthode, on peut générer des PDF que les utilisateurs vont pouvoir modifier et renvoyer à
l'expéditeur. Exemple d'un contrat pour une AMAP :

Exemple de formulaires PDF [cf. Contrat_Fruits_Legumes_Hiver_2015_A4.pdf]

Création et Configuration d'un formulaire Méthode

Création de formulaires [cf. Formulaires_Creation.mp4]
Configuration d'un formulaire [cf. Formulaires_Configuration.mp4]

Protéger le formulaire

Une fois le formulaire réalisé, on peut vouloir le protéger pour en faire un modèle de document. Pour
cela, il faut sélectionner le formulaire et utiliser la fonction protéger. Pour cela, il sera plus simple de
réaliser le formulaire dans un tableau que l'on protégera.

Plus d'informations sur le site d'aide de The Document Foundation. Complément

Document complémentaire et complet sur les formulaires :

Utiliser les formulaires [cf. WG4015FR-UtiliserLesFormulaires.pdf]

2. Activités Pratiques sur les formulaires

Objectifs
Réaliser un petit QCM rapide à distribuer à ses élèves.

Réaliser une zone de liste liée à une base de données

2.1. Créer un QCM rapidement

Un exemple à adapter... Exemple

Voici le QCM que l'on pourra réaliser rapidement :

Champ texte pour saisir le Nom et le Prénom

Choix déroulant de la classe parmi vos classes

Boutons radios 'oui' / 'non' de réponse à la question : "Est-ce que LibreOffice est installé chez
vous ?"

Cases à cocher pour répondre à la question 'Avez-vous un accès à internet ?' : Oui en ADSL, Oui
en Fibre, Oui en 3G/4G, non.

Méthode

1. Activer le mode ébauche

2. Insérer un contrôle de formulaire en cliquant sur l'icône du contrôle souhaitée, le pointeur de la
souris change d'icône

3. Cliquer dans le document à l'endroit souhaité

4. Tout en maintenant enfoncé le bouton de la souris, glisser le contrôle pour le dimensionner

5. Le bouton reste actif, on peut en dessiner de nouveau

6. Cliquer sur la flèche pour pour stopper la création des contrôles

Les Formulaires
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7. Une fois dessinés, les contrôles seront configurables en double-cliquant dessus.

8. En quittant le mode Ébauche, on pourra tester le formulaire et exporter en PDF

2.2. Zone de liste dynamique de contenus

Méthode

1. Créer un tableau Calc avec une en-tête nom et quelques noms d'élèves dessous, puis enregistrer.

2. Dans Writer, on va sélectionner la base de données en faisant Edition > Changer la base de
données

3. On parcourt pour trouver notre tableau, et on définit cette base avec le bouton Définir (dérouler
la base jusqu'à trouver la feuille)

4. Il apparaît, à présent, si on fait Affichage > Sources de données.

5. Créer une zone de liste en sélectionnant la base de données précédemment introduite dans
notre liste de sources de données rattachées à notre LibreOffice (inclus dans le profil).

Les Formulaires
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Calc : le module Tableur IV

Les besoins du module Tableur pour les enseignants peuvent être nombreux mais globalement nous
avons tous les mêmes problématiques :

gestion d'une liste d'élèves,

gestion de notes avec calcul automatique,

mise en forme conditionnelle,

autofiltre pour gagner du temps,

publipostage éventuel...

table de pilote pour des besoins très particuliers.

1. Utilisation générale d'un tableur

Télécharger le fichier suivant et lire les consignes ci-dessous.

Exemple de fichier pour la correction d'un contrôle commun [cf. Exemple_Notation_DS_Commun.ods]

Jongler entre les feuilles Méthode

Dans ce fichier, il y a 2 feuilles au classeur :

1. Total

2. Notes_QCM

Dans la 2ème, faire une liste d'élèves en écrivant Elève1 dans la deuxième ligne (sous Nom) puis en
étirant (utilisation de l'angle bas - droit de la cellule) jusqu'à la 61ème ligne. Les cellules devraient être
toutes différentes.

Répercuter cette liste d'élèves et de notes du QCM dans la première feuille Total. Pour cela, on se place
dans la première cellule, on met un signe = puis on va sélectionner la cellule à copier, tout simplement !
Reste ensuite à tirer vers le bas...

Quelques formules à connaître Syntaxe

Réaliser les différents calculs en bas de la colonne QCM :

Moyenne générale (fonction MOYENNE())

Moyenne Classe1

Moyenne Classe2

Note Maxi (fonction MAX())

Note Mini (fonction MIN())

Pour réaliser un calcul avec une formule, il faut insérer le signe = puis taper la formule, ou bien utiliser
l'assistant de fonctions.
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Assistant fonctions

Poursuivre en complétant les différentes colonnes où sont notés des commentaires d'explication (petit
point rouge). Pour arrondir, on pourra utiliser la fonction PLAFOND()et pour faire un test, la fonction
SI().

Conserver la même cellule lors d'une recopie ou lorsqu'on étire Fondamental

Une vidéo pour mieux comprendre !

Attention toutefois, pour passer d'une cellule relative (B4) à une cellule absolue ($B$4), il faut utiliser le
raccourci clavier F4 et pas Maj+F4 comme le dit la vidéo (référence à une vieille version de LibreOffice).

[cf. Références relatives et absolues]

AutoFiltre Complément

C'est une option très pratique quand on manipule beaucoup de données en colonne, la fonction se
trouve dans Menu Outils -> AutoFiltre. Voici un exemple pour sʼentraîner.

Inventaire ordinateurs [cf. exemple_inventaire_pc.ods]

Dans ce fichier, on pourra trier les différentes colonnes et ainsi, déterminer le nombre de PC de telles
ou telles marques.

Pour cela, on pourra utiliser la fonction NBVAL() et SOUS.TOTAL(). On trouvera de l'aide pour
SOUS.TOTAL() ici : https://wiki.documentfoundation.org/FR/Calc:_fonction_SOUS.TOTAL

2. Formatage conditionnel

Des couleurs ! Méthode

Il peut être pratique de mettre en évidence des cellules en fonction des valeurs contenues.

Exemple, une cellule en vert si la note est supérieure à 12, rouge si inférieure à 8...

Calc : le module Tableur
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La méthode est assez simple et autant utiliser un style dès le départ :

création d'autant de styles de cellules qu'il y a de conditions à définir

sélection de notre plage de cellule

menu Format -> Formatage conditionnel -> Condition

Définir notre condition en utilisant les styles prédéfinis

On peut ajouter autant de condition que l'on souhaite pour notre plage.

L'entrée du menu Format -> Formatage conditionnel -> Gérer permet de consulter l'ensemble des
conditions de notre classeur.

Des icônes ! Complément

Fonctionnalité peu connue, on peut aussi utiliser des jeux d'icônes pré-définis !

[cf. Formatage conditionnel avec un jeu d'icônes]

3. Créer un tableau dynamique

Définition

Une table dynamique est un outil conçu pour combiner, comparer et analyser facilement de grandes
quantités de données. Avec la table dynamique, vous pouvez effectuer différentes synthèses de la
source de données, afficher les détails de vos zones d'intérêt et créer des rapports, que vous soyez un
utilisateur débutant, intermédiaire ou avancé.

Pour lancer la création d'une table dynamique, 2 choix :

1. Menu Insertion -> Table dynamique...

2. Menu Données -> Table dynamique -> Créer...

[cf. Tableau croisé dynamique - Table dynamique]

Calc : le module Tableur
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Publipostage V

Le terme publipostage désigne une fonction des logiciels de traitement de texte permettant de
personnaliser automatiquement les termes d'une lettre-type envoyée à un ensemble de clients ou de
prospects. Les informations individuelles contenues dans le fichier des clients sont intégrées (on dit aussi
fusionnées) dans la lettre-type, ce processus permettant d'éditer autant de lettres personnalisées qu'il y
a de clients enregistrés dans le fichier.

1. Principe du publipostage

Méthode de création Méthode

Principe du publipostage

Pour créer un publipostage, il faut réaliser 3 opérations :

1. Création d'un document principal, appelé document de base dans LibreOffice

2. Création d'une sources de données

3. Création du document fusionné à imprimer, sauvegarder ou envoyer par courriel
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2. Création du document de base

Pour créer le document de base, il n'y a pas de difficulté particulière. On construit notre document
comme un document standard, sans personnalisation, i.e. pas de nom, prénom, personnalisation qui
seront rajoutés automatiquement par fusion grâce à la source de données.

Ensuite, le menu utilisé par le publipostage se trouve dans le menu Outils -> Assistant Mailing...

La vidéo ci-dessous vous permettra d'être autonome pour réaliser ce document de base :

Création du document de base [cf. 46- Definition_creation_doc_principal.mp4]

3. Création d'une source de données

Il y a plusieurs méthodes pour créer notre source de données :

1. Utilisation de l'interface graphique de l'assistant mailing (Cf vidéo)

2. Utilisation d'un classeur crée dans LibreOffice Calc (un enregistrement par ligne d'une feuille de
calcul)

Utilisation de l'interface graphique de l'assistant mailing Méthode

Création d'une source de données via l'outil Assistant Mailing [cf. 47- Creation_source_donnees.mp4]

Utilisation d'un tableau crée dans LibreOffice Calc Méthode

Utilisation d'une source de données existante [cf. 49- Creation_publipostage.mp4]

4. Finalisation du publipostage

Une fois notre document de base réalisé, notre source de données importées, nous pouvons passer à la
dernière étape de fusion afin de générer :

1. De nouveaux fichiers personnalisés

2. Des impressions pour un envoi sous pli

3. Des documents afin de les envoyer par courriel

Publipostage
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Principe du publipostage

Méthode

[cf. 48- Creation_champs_fusion_finalisation.mp4]

5. Activité Pratique sur le publipostage

Objectifs
Réaliser un courrier type pour informer les élèves de leur note au DS par 2 méthodes :

une lettre personnalisé

un courriel

5.1. Créer un publipostage simple

Un exemple à adapter... Exemple

Réaliser un petit courrier type non personnalisé pour informer les élèves de leur note

Lancer l'assistant mailing

Dans la source de données, compléter les champs Nom, Prénom existants et ajouter les champs
personnalisés Note_DS et Classe.

Modifier votre document de base pour ajouter les champs précédents :

Appui sur lʼicône Source de données ou appui sur F4.

Menu Insertion -> Champ -> Autres Champs (CTRL+F2)

Publipostage
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Générer un fichier individuel pour tous les élèves

Utiliser une source de données déjà réalisée Exemple

Refaire la procédure mais cette fois-ci, en utilisant un tableau comme source de données, réalisé au
préalable dans Calc.

Pour cela :

Préparer votre tableau avec pour première ligne les noms des champs

Enregistrer le tableau

Depuis le document de base sur Writer, se rendre dans le menu Insertion -> Champs -> Autres
pour sélectionner une nouvelle base de données.

Afficher les sources de données en appuyant sur F4 ou menu Affichage -> Source de données

Développer la source de données dans le nouveau menu comme indiqué ci-dessous

Puis glisser les champs directement dans le document de base

Publipostage
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Impress : le module Présentation VI

Le module de présentation Impress a beaucoup évolué durant les dernières versions. Nous allons voir
dans ce module la partie création d'un modèle afin de ne pas perdre de temps pour la création de vos
nouvelles présentations.

Le format de fichier comporte l'extension .odp. Un modèle de présentation aura l'extension .otp.

Impress permet également de lire des documents issus de la suite Office© au format propriétaire de
fichiers .ppt ou .pptx.

1. Concevoir une présentation

Outre un soigneux agencement du contenu, il est nécessaire de songer à l'aspect de la présentation en
se posant quelques questions simples :

• Quelles combinaisons de couleurs (arrière-plan et texte) seront les plus lisibles par votre public ?

• Une image aidera-t-elle à la compréhension du contenu ?

• Voulez-vous faire apparaître une image ou un texte particulier sur toutes les diapositives ?

• Votre public pourra-t-il se référer plus rapidement à l'une des diapositives si celles-ci sont numérotées
?

• Voulez-vous un arrière-plan graphique ?

• Vous faudra-t-il un ou plusieurs masques ? Un seul design conviendra-t-il à tout le contenu ?

Remarque

Vous pouvez bien sûr modifier l'aspect des diapositives tout en créant la présentation, mais y réfléchir
avant vous fera globalement gagner du temps.
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Qu'est-ce qu'une page maîtresse ?

Une page maîtresse est une diapositive utilisée comme point de
départ pour en créer d'autres. Elle ressemble à un style de page
dans LibreOffice Writer : elle contrôle la mise en page de toutes les
diapositives qui s'y réfèrent. Un diaporama peut utiliser une ou
plusieurs pages maîtresses.

Toutes les caractéristiques des pages maîtresses sont contrôlées
par des styles. Les styles de chaque nouvelle diapositive sont
hérités de la page maîtresse à partir de laquelle elle a été créée.

Impress est livré avec une
collection de pages maîtresses.

Mises en pages prédéfinies pour
Impress

Pour chaque page maitresse, nous disposons de 12 mises en
pages prédéfinies

Masque de diapositive Rappel

Une page maîtresse se base sur un masque de diapo. Il faut donc créer un nouveau masque pour créer
une nouvelle page maîtresse.

Une prise en main en vidéo... Complément

[cf. Prise en main d'Impress]

2. Créer un modèle en utilisant les pages maîtresses

Mieux qu'un long discours, voici une vidéo tutoriel afin de créer un nouvelle modèle de document
Impress. Ce modèle est basé sur le modèle de Fernando Ribeiro (Light Gray Impress Template), trouvé
sur le site de templates de LibreOfficeCentre de templates (modèles) de LibreOffice p.47.

[cf. Créer un modèle Impress]

Impress : le module Présentation
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Méthode

Voici la transcription de la vidéo :

activer le mode masque

définir la mise en page (couleurs, police, taille...) en modifiant le masque existant

modifier les styles pré-définis

ajustement des zones d'objets pour les mises en pages automatiques

ajout d'un nouveau masque qui va permettre de créer une 2ème page maîtresse pour ce
modèle

fermer le masque pour revenir au mode de création de la présentation

2 pages maîtresses sont à présent accessibles

enregistrer ce travail comme modèle pour pouvoir le retrouver facilement

3. La Console de Présentation

Cette console de présentation est un outil indispensable pour les conférenciers ou les enseignants, elle
permet d'avoir des informations sous les yeux que le public ne verra pas sur l'écran vidéo-projeté.

Cela nécessite donc deux affichages et ne fonctionne que lorsque deux moniteurs sont connectés (l'un
d'eux peut être l'écran de l'ordinateur portable) et que l'affichage est étendu aux deux écrans.

L'écran du présentateur inclut la diapositive courante, la prochaine, les notes de présentation (voir
l'onglet Notes d'Impress) et un minuteur.

Capture Console Présentation de LibreOffice

Impress : le module Présentation
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Les Extensions VII

LibreOffice offre une multitude d'extensions qui en font un produit évolutif et très complet, notamment
dans les usages éducatifs !

Le site des extensions : http://extensions.libreoffice.org/

La gestion des extensions dans LibreOffice se fait à l'aide du menu Outils ▸ Gestionnaire des
extensions... Passons en revue quelques extensions pertinentes pour les enseignements.

1. OooHG

Plus de 1600 fonds de cartes pour les enseignants d'Histoire et Géographique

815 fonds de cartes vectoriels classés par
espaces (750 en Géo.) ou périodes (65 en Hist.)

135 objets géographiques vectoriels ponctuels
classés en 4 thèmes, pour créer ses croquis et
cartes

86 outils vectoriels ponctuels pour créer ses axes
chronologiques

265 cartes et graphiques bitmap de géographie à
insérer dans ses documents

536 cartes et graphiques bitmap d'histoire à
insérer dans ses documents
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Exemple

Complément

Pour télécharger OooHG, il faut se rendre sur le site dédié : http://ooo.hg.free.fr/

2. Dmaths

Une barre d'outils pour les mathématiciens, des schémas pour les scientifiques...

Facilite l'édition de formules mathématiques et/ou
scientifiques, et propose des schémas vectoriels tout
faits !

Incorpore des graphes de fonctions dans un document

Les Extensions

cedric.frayssinet@ac-lyon.fr 33

http://ooo.hg.free.fr/


Exemples de macros intégrées à Dmaths

Des macros facilitent le travail des scientifiques...

Complément

Pour télécharger l'extension, rendez-vous sur le site dédié : http://www.dmaths.org/

Remarque

Depuis quelques mois, pour obtenir l'extension, il faut adhérer au club Dmaths en versant une
contribution de 10€.

3. Grammalecte

Correcteur grammatical Open-Source pour LibreOffice

Grammalecte essaie d'apporter une aide à l'écriture du français sans
parasiter l'attention des utilisateurs avec de fausses alertes.

Ce correcteur suit donc le principe suivant : le moins de « faux positifs
» possible ; s'il n'est pas possible de déterminer avec de fortes
chances qu'une suite de mots douteuse est erronée, le correcteur ne
signalera rien.

Remarque

Grammalecte est en perpétuel développement, le développeur a levé des fonds récemment pour
l'améliorer via un crowdfunding p.45 sur Ulule.

Les Extensions
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Lexicographie Exemple

Suggestions Exemple

Complément

Pour télécharger Grammalecte, il faut se rendre sur le site dédié : http://www.dicollecte.org/

4. Lire Couleur

Des outils pour l'aide à la lecture

LireCouleur est un ensemble d'outils destiné à aider les lecteurs débutants ou en difficulté à décoder
les mots en utilisant les principes de la lecture en couleur.

Ces outils peuvent également servir aux élèves dyslexiques et aux personnes apprenant le Français
comme langue étrangère.

Plus d'informations sur le site dédié : http://lirecouleur.arkaline.fr/

Les Extensions

cedric.frayssinet@ac-lyon.fr 35

http://www.dicollecte.org/
http://lirecouleur.arkaline.fr/


Exemple

Mise en évidence des syllabes

5. Activité Pratique : Extensions de LibreOffice

Objectifs
Maîtriser l'installation d'extensions

5.1. Installation d'extensions

Installation des extensions Méthode

Récupérer sur les sites dédiés ou sur un partage réseau au moins 2 extensions présentées

Les installer

Modifier les barres des extensions

Format de fichiers des extensions Remarque

Les extensions portent l'extension .OXT p.46.

Elles s'installent, soit sur la machine (utilisables par tous les utilisateurs), soit dans le profil de
l'utilisateur.

Du coup, dans un établissement scolaire, on peut installer l'extension et la retrouver sur tous les postes
informatiques sur lesquels on se connecte.

5.2. Usages des extensions

Faire quelques manipulations :

- insertion de graphiques d'OooHG (utilisation de la Gallerie)

- tests de grammalecte ou de Lire Couleur...

Les Extensions
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Trucs & Astuces VIII

1. De l'utilité des espaces insécables...

Il existe une notion qui est rarement abordé en
traitement de textes, il s'agit des espaces insécables...

De petits rectangles gris que LibreOffice
nous affiche par défaut !

Fondamental

« Ne pas couper les lignes à l'intérieur d'un paragraphe et distinguer les blancs entre mots de ceux à
l'intérieur d'un mot qui n'autorisent pas la coupure : espace (barre d'espacement) et espace insécable
(Combinaisons de touches Maj+Ctrl+Espace -> Touche Majuscule + Touche Contrôle + Barre
d'espacement) ».

Où placer les espaces insécables ? Rappel

En français, les espaces insécables se placent principalement :

avant la ponctuation haute : ? ! : ; ; (signes composés de 2 signes)

comme séparateur de milliers dans les nombres : 1 250 200 habitants ;

entre un nombre et le symbole d'unité : 1 200 m ;

entre l'initiale et le nom : J. DUPONT ;

entre le prénom et le nom : Jean Dupont ;

entre le titre et le nom : Monsieur Dupont.

Complément

Les principes du traitement de texte [cf. PrincipesTdt.pdf]
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2. Manipuler et positionner des images et autres objets

Pour placer une image ou un objet sur un document avec du texte, il faut définir son ancrage et choisir
le mode d'adaptation avec le texte de la page.

On peut ancrer :

à la page : Ancre l'élément sélectionné à la page active.

Au paragraphe : Ancre l'élément sélectionné au paragraphe actif.

Au caractère : Ancre l'élément sélectionné à un caractère.

Comme caractère : Ancre l'élément sélectionné comme caractère dans le texte actif. Si la
hauteur de cet élément est supérieure à la taille de police utilisée, la ligne contenant l'élément
est agrandie en conséquence.

Concernant lʼadaptation au texte :

Pas adaptation : Place l'objet sur une ligne distincte dans le document. Le texte du document
apparaît au-dessus et en dessous de l'objet, mais pas sur les côtés.

Renvoi relatif à la page : Adapte le texte tout autour du cadre de l'objet.

Renvoi dynamique à la page : Adapte automatiquement le texte à gauche, à droite ou tout
autour du cadre de l'objet. Si la distance entre l'objet et la marge de page est inférieure à 2 cm, le
texte n'est pas adapté.

Adaptation continue : Place l'objet devant le texte.

3. Importer des styles d'un autre modèle

Copier styles d'un modèle [cf. Copier_styles_modeles.mp4]

4. Utiliser des colonnes

Il est souvent nécessaire dans notre travail d'enseignant d'optimiser le papier et de bien remplir les
documents fournis aux élèves. Pour cela, nous pouvons utiliser les colonnes :

Disposer du texte en colonne [cf. Disposer_txt_colonnes.mp4]
Insérer un saut de colonne [cf. Saut_colonnes.mp4]

Trucs & Astuces
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5. Personnaliser l'interface de LibreOffice

Modifier les icônes

LibreOffice est livré en standard avec des jeux dʼicônes. Il y a peu, de nouveaux jeux d'icônes sont
apparus :

Jeu d'icônes Sifr

Jeu d'icônes Breeze

Pour modifier les jeux d'icônes, il faut se rendre dans le menu Outils → Options → LibreOffice →
Affichage

Ajout d'un thème

Tout comme on peut utiliser des thèmes Firefox (Personas), on peut personnaliser LibreOffice avec les
nombreux thèmes issus de Firefox. Pour cela, il suffit de se rendre dans les options :

Fenêtre de personnalisation de LibreOffice dans les options

En cliquant sur Sélectionner un thème, vous pouvez définir une thématique - fleur, abstract, nature... -
et visualiser des thèmes avant de les sélectionner. Voici un exemple de résultat :

Personnalisation de LibreOffice

Trucs & Astuces
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6. Numérotation des lignes d'un document

Il est souvent nécessaire, notamment pour les sciences humaines, d'avoir des paragraphes avec des
lignes numérotées pour amener les élèves à commenter des phrases.

Nous pouvons faire cela très facilement avec LibreOffice et ses styles.

Méthode

1. Ouvrir un nouveau document texte et taper tex puis la touche F3. Cela permet d'avoir un
paragraphe de texte.

2. Afficher la numérotation des lignes via le menu Outils → Numérotation des lignes

3. A ce niveau, tous les paragraphes, tous les styles y compris les titres disposeront d'une
numérotation de ligne. Ce n'est pas forcément le but voulu, notamment, la numérotation des
titres.

4. Pour supprimer la numérotation d'un paragraphe, d'un titre ou d'un autre style, il faut modifier
le style en question en décochant la case Inclure les lignes de ce paragraphe dans l'onglet Plan
& Numérotation du style de paragraphe.

5. Si vous souhaitez ne pas numéroter tous vos paragraphes :

à partir du styliste (F11), créer un nouveau style de paragraphe basé sur le style par défaut,
nommez le paragraphe_non_numéroté

décochez la case Inclure les lignes de ce paragraphe dans le style dont vous souhaitez
supprimer la numérotation

appliquez le style paragraphe_non_numéroté à votre paragraphe à numéroter.

Exemple de numérotation

7. Création d'étiquettes avec publipostage

Afin de pouvoir comprendre cette vidéo, il faut impérativement avoir compris le publipostage (cf. p.25).

Création d'étiquettes en publipostage [cf. 51- Planche_etiquettes.mp4]

Trucs & Astuces
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1 https://wiki.documentfoundation.org/Faq/General/110/fr#Comment_purger_son_profil.5B1.5D_.3F

8. Dépannage : purger son profil LibreOffice

La configuration du logiciel est stockée dans des fichiers de configuration. Ces fichiers sont modifiés,
parfois de manière évidente (via le menu Outils ▸ Options par exemple), parfois sans que l'utilisateur
en ait conscience (mémorisation des dimensions et positions des fenêtres ou barre d'outils par
exemple).

Lors de la réécriture de ces fichiers de configuration il peut arriver que certains soient corrompus :
élément mal enregistré, XML non valide, etc.

La cause est difficilement identifiable car il va de soi que le logiciel ne devrait pas permettre que ces
erreurs se produisent. Certaines peuvent s'expliquer par des micro-coupures de courant lors de
l'enregistrement, ou un problème de gestion de mémoire, voire par des modifications hasardeuses des
options, l'installation d'extensions défectueuses, la manipulation directe de ces fichiers, etc.

Pour vérifier s'il s'agit d'un bogue propre à LibreOffice ou d'un défaut de paramétrage, il est conseillé
dans un premier temps de purger son profil pour retrouver les options par défaut.

Procédure de purge de son profil Méthode

Vous trouverez la procédure complète sur le site de LibreOffice, sur cette page1.

Remarque

Ce profil n'est pas visible sur les réseaux des établissements scolaires. Il faudra donc le faire réinitialiser
par votre référent numérique.

Trucs & Astuces
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1 https://www.collaboraoffice.com/
2 https://framadrive.org/

Quel avenir ? Les nouveaux usages... IX

Il est naturel de se poser la question de la pérennité d'une telle suite bureautique face à des géants du
logiciel comme Microso�© ou Google©.

LibreOffice est en perpétuel développement et apparaît progressivement sur les nouveaux matériels
tels que les smartphones ou les tablettes.

LibreOffice On Line : LooL, appelé à présent Collabora Online

LibreOffice en mode cloud est en cours de développement. Il s'agit d'une version de LibreOffice qui
sera accessible uniquement avec un navigateur. C'est développé actuellement par Collabora1.

Le gros avantage de cette solution est qu'elle pourra être intégrée gratuitement par exemple sur un
Espace Numérique de Travail, et ne nécessitera pas la création de comptes utilisateurs.

Actuellement, des outils tels que OwnCloud, NextCloud ou Pydio l'ont déjà intégré :

LibreOffice en mode Cloud

Pour information, Framaso�, une association lyonnaise de promotion de logiciels libre propose
gratuitement FramaDrive2, basé sur OwnCloud.
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1 https://itunes.apple.com/fr/app/libreoffice-remote-for-impress/id806879890?mt=8

LibreOffice sur smartphone et tablette

Actuellement, on trouve 2 applications Android
maintenues par The Document Foundation :

1. Une visionneuse de fichiers ODF : https://play.go
ogle.com/store/apps/details?id=org.documentfou
ndation.libreoffice. Cette visionneuse évolue et
intègre petit à petit des modes d'édition
minimalistes de fichiers.

2. Une télécommande pour piloter les diaporamas
Impress : https://play.google.com/store/apps/det
ails?id=org.libreoffice.impressremote (également
disponible1 pour iPhone ou iPad)

Applications Android pour LibreOffice

Quel avenir ? Les nouveaux usages...
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1 http://fr.libreoffice.org/download/libreoffice-stable/
2 https://wiki.documentfoundation.org/FR/La_documentation_de_l%27utilisateur#Les_tutoriels_ou_How-to
3 https://www.youtube.com/channel/UC0APTipioCC2VRFoUnX8VtQ/videos

Obtenir de l'aide X

Il existe différentes sources pour obtenir de l'aide sur LibreOffice, la plupart sont listées
sur cette page d'accueil :

Depuis le logiciel

Lors de l'installation de LibreOffice, vous pouvez installer l'aide si vous le souhaitez. Sinon une
connexion internet est nécessaire pour accéder à l'aide depuis LibreOffice.

On peut télécharger l'aide depuis cette page1.

On peut lancer l'aide du logiciel avec la touche fonction F1.

Guides utilisateurs

De nombreux guides à l'attention des utilisateurs ont été rédigés par des contributeurs bénévoles. On
peut les retrouver via le menu Aide -> Guides utilisateur...

On les retrouve sur cette pageGuides Utilisateur Officiels p.47.

Foire Aux Questions

Nous avons souvent les mêmes questions à poser, de nombreuses réponses aux questions
fréquemment posées sont listées sur cette pageFoire Aux Questions autour de LibreOffice p.47.

Tutoriels

De nombreux tutoriels sont disponibles pour l'ensemble des modules de LibreOffice ; ils sont listés sur
cette page2.

Une chaîne YouTube3 est particulièrement intéressante, elle est alimentée par Pierre-Yves Samyn,
contributeur LibreOffice.

Aide en ligne

On peut également obtenir de l'aide via un formulaire en ligne.

Vous précisez votre question et le courriel arrive sur la liste de diffusion des utilisateurs francophones
de LibreOffice. Vous obtiendrez une réponse très rapidement.

Pour accéder au formulaire, il suffit d'aller dans le menu Aide -> Obtenir de l'aide en ligne...
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Glossaire

Crowdfunding

Financement participatif via des plateformes sur internet : Ulule, KickStarter...

GNU

GNU est un projet de système d'exploitation libre lancé en 1983 par Richard Stallman, puis
maintenu par le projet GNU.

GNU/Linux (souvent appelé Linux) est une variante du système d'exploitation GNU fonctionnant
avec le noyau Linux. Le projet GNU avait originellement prévu le développement du noyau Hurd
pour compléter le système, mais au début des années 1990, Hurd ne fonctionnait pas encore et
son développement rencontrait encore des difficultés. L'arrivée du noyau Linux permit l'utilisation
du système GNU sur les ordinateurs animés par des microprocesseurs de la famille Intel x86, en
favorisant sa large diffusion par la complémentarité des projets.

The Document Foundation

The Document Foundation est une organisation appartenant au monde du logiciel libre. Elle a
pour objectif de créer et gérer LibreOffice, un logiciel dérivé de la suite bureautique
OpenOffice.org.

Certaines personnes membres du projet OpenOffice.org ont rejoint le projet et sont au bureau de
la fondation. Certains membre du bureau ne participaient pas à OpenOffice.org.
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Abréviations

ODF : Open Document Format. Format de fichiers, normalisé et ouvert, utilisé par LibreOffice par défaut,
il est également proposé par Office depuis la version 2010.
OXT : OXT est le format de fichier d'une extension pour LibreOffice
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Webographie

https://help.libreoffice.org/Main_Page/fr

https://extensions.libreoffice.org/templates

Des vidéos courtes et forts utiles pour mettre en
lumière des aspects méconnus de LibreOffice

Des vidéos courtes et forts utiles pour
mettre en lumière des aspects méconnus de LibreOffice

https://wiki.documentfoundation.org/FR/FAQ

https://wiki.documentfoundation.org/Documentation/Publications/fr#Gui
des_utilisateur_officiels

https://fr.wikipedia.org/wiki/Office_Open_XML#Historique_des_votes_ISO

https://fr.wikipedia.org/wiki/M%C3%A9thode_agile

http://fr.libreoffice.org/ Attention, ne jamais télécharger LibreOffice depuis
un autre site.

De nombreuses courtes vidéos thématiques classées, ouvrir le
fichier texte auparavant  : �p://eoleng.ac-dijon.fr/mimo-
dev/Videos/FORMATION%20LIBREOFFICE%20INFPN/MP4/

[Aide en ligne de LibreOffice]

[Centre de templates (modèles) de LibreOffice]

[Chaîne Française Youtube de Pierre-Yves Samyn]

[Chaîne Française Youtube de The Document Foundation]

[Foire Aux Questions autour de LibreOffice]

[Guides Utilisateur Officiels]

[Historique des votes ISO]

[Qu'est-ce que la méthode Agile ?]

[Site Officiel de LibreOffice]

[Vidéos Tutoriels de la Police Nationale]
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